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What’s new in the C/AL Editor
•

Proper syntax highlighting

•

Line Numbers

•

Change Indicators

•

Intellisense

•

Table Definition from the Code Editor

•

Undo

•

Block changes

•

The “useoldeditor” option
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Proper syntax highlighting
All keywords are highlighted with BLUE
Hardcoded text is highlighted with RED
Inactive code ig GREEN regardless if the code has been disabled with // or the { }.
Local functions are now prefixed with LOCAL.
Events in the code are marked with :: eg. The Host::AddInready()

Line numbers
Line numbers are implemented in the code to give an indication of where in the code the cursor is situated.

Change indicators
Whenever a change is made the change indicator will mark each line with a yellow line.
The change indicator will change color to green when it has been compiled or saved.
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Auto-complete intellisense style
Typing code will open intellisense windows suggesting the relevant field names or actions available.

Syntax Tooltips
When selecting a function from the intellisense the syntax will be suggested.

Table Definition from the Code Editor
Hovering the cursor over a record variable in the editor will open a window showing all fields in the record.
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Undo
As something new the editor will record all changes made while working in the editor enabling undo all the way
back to when the object was opened. This also include saving and compiling the object.
Closing the editor will reset the undo records.
This means that to utilize this best the object must be kept open all the time wirking on a change.

Block changes
Sometimes it is necessary to change the variable of many lines at once.

An example could be that the Customer variable must be changed into the Vendor variable.
Now this is possible by using block change:
Clice on the first letter of the Customer variable then hold the Alt key down and drag to the last character of
the Customer variable on the bottom line.

Pressing Delete here vill delete the block.
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Starting to type Vendor will change all line in one go.

The repeating it on the OldCustomer Variable.

The “useoldeditor” Option
If for some reasom the new editor does not aggree with you, it is possible to revert to the old editor by starting
the development environment up with a paramater:
useoldeditor
Create a new shortcut:

Open properties and add the parameter to the destination field:
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And now it is back to normal.
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Events






What Are Events?
How Events Work
Event types
Event areas
How to Implement Events
o Publishing an event
o Raising an event
o Subscribing to Events
o Example of an Event Suscriber Function

This chapter is a compilation of available Microsoft material. More information can be found at
https://msdn.microsoft.com/en-us/library/mt299398(v=nav.90).aspx
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What Are Events?
Dynamics NAV 2016 introduces a new type of integration point – events. Events are a C/AL feature in which an
object maintains a list of its subscribers, and notifies them automatically of any state changes. This is done by
calling one of the subscriber methods. Subscriber methods need not be in the same object and this fact
enables integration developers to build decoupled systems. Dynamics NAV solutions can be written interfering
or rewriting much less any of the base application code.
You can use events to design the application to react to specific actions or behavior that occur. Events enable
you to separate customized functionality from the application business logic. By using events in the application
where customizations are typically made, you can lower the cost of code modifications and upgrades to the
original application.


Code modifications to customized functionality can be made without having to modify the original
application.



Changes to the original application code can be made with minimal impact on the customizations.

Events can be used for different purposes, such as generating notifications when certain behavior occurs or the
state of an entity changes, distributing information, and integrating with external systems and applications. For
example, in the CRONUS International Ltd. demonstration database, events are used for extensively for workflow
and Microsoft Dynamics CRM integration.

How Events Work
The basic principal is that you program events in the application to run customized behavior when they occur.
Events in Microsoft Dynamics NAV are modelled after Microsoft .NET Framework. There are three major
participants involved in events: the event, a publisher and a subscriber.
An event is the declaration of the occurrence or change in the application. An event is declared by a C/AL
function, which is referred to as an event publisher function. An event publisher function is comprised of a
signature only and does not execute any code.
A publisher is the object that contains event publisher function that declares the event. The publisher exposes
an event in the application to subscribers, essentially providing them with a hook-up point in the application.
Publishing an event does not actually do anything in the application apart from making the event available for
subscription. The event must be raised for subscribers to respond. An event is raised by adding logic to the
application that calls into the publisher to invoke the event (the event publisher function).
Partners or subsystems can then take advantage of the published event in their solutions. An ISV that delivers
vertical solutions, and Microsoft itself, are the typical providers of published events.
There are three different event types: business, integration, and trigger events. For more information about
each type, see Event Types. Business and integration type events must be explicitly declared and published,
which means that you must create event publisher functions and add them to objects manually. On the other
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hand, trigger events, which occur on table and page operations, are published and raised implicitly by the
Microsoft Dynamics NAV runtime. Therefore, no coding is required to publish them.
A subscriber listens for and handles a published event. A subscriber is a C/AL function that subscribes to a
specific event publisher function and includes the logic for handling the event. When an event is raised, the
subscriber function is a called and it code is run. A subscriber enables partners to hook into the core Microsoft
Dynamics NAV application functionality without having to do traditional code modifications. Any Microsoft
Dynamics NAV solution provider, which also includes Microsoft, can use event subscribers.
There can by multiple subscribers to a single event publisher function. However, a publisher has no knowledge
of subscribers, if any. Subscribers can reside in different parts of the application than publishers.

Event types
Microsoft Dynamics NAV supports different types of events for different purposes. This topic describes the
following event types:

Business Events
A business event is a custom event that is raised by C/AL code. It defines a formal contract that carries an
implicit promise not to change in future releases. It is the expectation that business events are published by
solution ISVs, including Microsoft.
Business events can be compared with publicly released APIs on which 3rd party solution provider develop
integrations and additions. Therefore, the downstream cost of making changes to a business event
implementation can be considerable for those who use the event in their applications. There may be some
cases where changes are required; however, you should keep these to an absolute minimum.
Development considerations
A typical business event reflects changes in “state” with regards to a process. This makes them very well suited
for workflow. An example of a business event could be when a sales order has been posted. It is important to
note that business events should not be tied to the implementation-details, such as the tables or fields in which
the data is stored. Preferably, the event publisher developer should be free to change the implementation,
while still keeping the business event intact.
Business events should be documented with the solution, including the before-state and after-state of the
events.
Integration Events
An integration event is also a custom event that is raised by C/AL code, like a business event, except that it
does not carry the same promise of not changing, nor does it have the restriction not to expose
implementation details.
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The main purpose of integration events is to enable the integration of other solutions with Microsoft Dynamics
NAV without having to perform traditional code modifications.
Development considerations
An integration event can be changed to a business event later. At which time, it must adhere to the same
implied contract and commitment as any business event. It can also simply be designed-in hook points for
external add-ons.
Global Events
Global events are predefined system events that are automatically raised by Codeunit 1
ApplicationManagement. Codeunit 1 includes several global function triggers, such as CompanyOpen,
CompanyClose, and GetSystemIndicator. For most of these global function triggers, there are one or two global
events: a before and after event. For example, there is an OnBeforeCompanyOpen event and an
OnAfterCompanyOpen event. The global events are defined as integration events by local functions in codeunit
1.
Trigger Events
Unlike business and integration events which must be programmed, trigger events are predefined events.
Trigger events are published by the runtime and they cannot be raised programmatically. There are two types
of trigger events as described in this section: database trigger events and page trigger events.

Event areas
In addition to providing the capability to define your own events, the Dynamics NAV application comes with a
set of events in different areas of the product. This document lists those events.
Posting
These events are for building solutions that extend the application posting without making changes to the
posting codeunit themselves. Consider using these events instead of modifying the posting codeunits as it will
improve the future upgrade of your solution.
Codeunit 1 Events
Many integration projects include changing and utilizing Codeunit 1 methods. These events are for building
solution that extend the application without changing Codeunit 1 itsel
Workflow Events
The workflow events are all events that support the implementation of the out-of-the-box approval, notification,
and process automation functionality. Using workflow events allows you to extend Microsoft workflows with
custom functionality.
Workflow Extension Events
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Use these events when you want to enable new types of workflows by making new workflow events and
workflow responses. Using the library events below will ensure that your events show up in the Workflow
Designer so that end users can take advantage of them.
CRM Integration Extensions
These events can be used to extend the CRM integration by adding custom mapping and more.
Trigger Events
Unlike business and integration events which must be programmed, trigger events are predefined events. Trigger
events are published by the runtime and they cannot be raised programmatically. There are two types of trigger
events: database trigger events and page trigger events.
Database Trigger Events
Trigger events are automatically raised by the system when it performs database operations on a table object,
such as deleting, inserting, modifying, and renaming a record, as defined in a table. Trigger events are closely
associated with the table triggers for database operations: OnDelete, OnInsert, OnModify, OnRename, and
OnValidate (for fields). For each database operation, there is a "before" and "after" trigger event with a fixed
signature.
Page Trigger Events
Page Trigger events are raised automatically by the system when it performs certain operations in a page object.
Page trigger events are closely associated with the standard page triggers, such as OnOpenPage. OnClosePage,
and OnAction.

In addition to providing the capability to define your own events, the Dynamics NAV application comes with a
set of events in different areas of the product. This document lists those events.
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Posting
Area
G/L

Item

Purchase

Sales

Event Name
OnAfterCopyCustLedgerEntryFromGenJnlLine
OnAfterCopyGLEntryFromGenJnlLine
OnAfterCopyVendLedgerEntryFromGenJnlLine
OnAfterCheckGenJnlLine
OnAfterInsertGlobalGLEntry
OnAfterInitGLRegister
OnBeforePostGenJnlLine
OnBeforeInsertGLEntryBuffer
OnAfterInitItemLedgEntry
OnAfterInsertCorrItemLedgEntry
OnAfterInsertCorrValueEntry
OnAfterInsertItemLedgEntry
OnAfterInsertValueEntry
OnAfterCheckItemJnlLine
OnAfterPostItemJnlLine
OnBeforeInsertCorrItemLedgEntry
OnBeforeInsertCorrValueEntry
OnBeforeInsertTransferEntry
OnBeforeInsertValueEntry
OnBeforePostItemJnlLine
OnAfterCalcPurchaseDiscount
OnAfterPostPurchaseDoc
OnAfterReleasePurchaseDoc
OnAfterReopenPurchaseDoc
OnBeforeCalcPurchaseDiscount
OnBeforePostPurchaseDoc
OnBeforePostCommitPurchaseDoc
OnBeforeReleasePurchaseDoc
OnBeforeReopenPurchaseDoc
OnAfterReleaseSalesDoc
OnAfterReopenSalesDoc
OnAfterCalcSalesDiscount
OnAfterSalesDocPost
OnBeforeReleaseSalesDoc
OnBeforeReopenSalesDoc
OnBeforeCalcSalesDiscount
OnBeforeSalesDocPost
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Publisher Object
Table 21
Table 17
Table 25
Codeunit 11
Codeunit 12
Codeunit 12
Codeunit 12
Codeunit 12
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 21
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 22
Codeunit 70
Codeunit 90
Codeunit 415
Codeunit 415
Codeunit 70
Codeunit 90
Codeunit 90
Codeunit 415
Codeunit 415
Codeunit 414
Codeunit 414
Codeunit 60
Codeunit 80
Codeunit 414
Codeunit 414
Codeunit 60
Codeunit 80

OnBeforeSalesDocPostCommit

Codeunit 80

Codeunit 1 Events
Event Name
OnAfterAutoFormatTranslate
OnAfterCaptionClassTranslate
OnAfterCompanyClose
OnAfterCompanyOpen
OnAfterFindPrinter
OnAfterGetApplicationVersion
OnAfterGetDatabaseTableTriggerSetup
OnAfterGetDefaultRoleCenter
OnAfterGetGlobalTableTriggerMask
OnAfterGetSystemIndicator
OnAfterMakeCodeFilter
OnAfterMakeDateFilter
OnAfterMakeDateText
OnAfterMakeDateTimeFilter
OnAfterMakeText
OnAfterMakeTextFilter
OnAfterMakeTimeFilter
OnAfterMakeTimeText
OnAfterOnDatabaseDelete
OnAfterOnDatabaseInsert
OnAfterOnDatabaseModify
OnAfterOnDatabaseRename
OnAfterOnGlobalDelete
OnAfterOnGlobalInsert
OnAfterOnGlobalModify
OnAfterOnGlobalRename
OnBeforeCompanyClose
OnBeforeCompanyOpen

Publisher Object
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1
Codeunit 1

- 16 -

Workflow Events
Area
Approvals

Incoming Document
OCR Integration

Purchase Document Posting

Sales Document Posting

Event Name
OnApproveApprovalRequest
OnCancelCustomerApprovalRequest
OnCancelGeneralJournalBatchApprovalRequest
OnCancelGeneralJournalLineApprovalRequest
OnCancelIncomingDocApprovalRequest
OnCancelItemApprovalRequest
OnCancelPurchaseApprovalRequest
OnCancelSalesApprovalRequest
OnCancelVendorApprovalRequest
OnDelegateApprovalRequest
OnRejectApprovalRequest
OnSendCustomerForApproval
OnSendGeneralJournalBatchForApproval
OnSendGeneralJournalLineForApproval
OnSendIncomingDocForApproval
OnSendItemForApproval
OnSendOverdueNotifications
OnSendPurchaseDocForApproval
OnSendSalesDocForApproval
OnSendVendorForApproval
OnAfterReleaseIncomingDoc
OnAfterCreateDocFromIncomingDocFail
OnAfterCreateDocFromIncomingDocSuccess
OnAfterIncomingDocReadyForOCR
OnAfterIncomingDocReceivedFromOCR
OnAfterIncomingDocSentToOCR
OnAfterPostPurchaseDoc
OnAfterReleasePurchaseDoc
OnAfterReopenPurchaseDoc
OnAfterReleaseSalesDoc
OnAfterReopenSalesDoc
OnAfterSalesDocPost
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Publisher Object
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 1535
Report 1509
Codeunit 1535
Codeunit 1535
Codeunit 1535
Codeunit 132
Codeunit 132
Codeunit 132
Codeunit 133
Codeunit 133
Codeunit 133
Codeunit 90
Codeunit 415
Codeunit 415
Codeunit 414
Codeunit 414
Codeunit 80

Workflow Extension Events
Event Name
OnAddWorkflowCategoriesToLibrary
OnAddWorkflowEventPredecessorsToLibrary
OnAddWorkflowEventsToLibrary
OnAddWorkflowResponsePredecessorsToLibrary
OnAddWorkflowResponsesToLibrary
OnAddWorkflowTableRelationsToLibrary
OnExecuteWorkflowResponse

Publisher Object
Codeunit 1502
Codeunit 1520
Codeunit 1520
Codeunit 1521
Codeunit 1521
Codeunit 1520
Codeunit 1521

CRM Integration Extensions
Event Name
OnAfterApplyRecordTemplate
OnAfterInsertRecord
OnAfterModifyRecord
OnAfterTransferRecordFields
OnBeforeApplyRecordTemplate
OnBeforeInsertRecord
OnBeforeModifyRecord
OnBeforeTransferRecordFields
OnFindUncoupledDestinationRecord
OnQueryPostFilterIgnoreRecord
OnRegisterServiceConnection

Publisher Object
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5335
Codeunit 5340
Table 1400

- 18 -

How to Implement Events
Implementing events in Microsoft Dynamics NAV consists of the following tasks:
Publish the event:

For business and integration events, create and configure a function in an application
object to be an event publisher function.

Raise the event:

Add code that calls the event publisher function.

Subscribe to the event: At the consumer end, add one or more subscriber functions that subscribe to
published events when they are raised.

Publishing an event
The first phase of implementing an event is publishing the event. Publishing an event exposes it in the
application. This provides hook up points for subscribers to register to the event, and eventually handle the event
if it is raised. An event is published by adding C/AL function that is specifically set up as an event publisher.


Business and integration events require that you manually create an event publisher function for each
event that you want to publish. An event publisher function declares the event in the application and
makes it available for subscription; however, it does not raise the event. After an event is published, you
can raise it in your application, as needed, from where event subscribers can react and handle the event.



Trigger events, on the other hand, do not require that you create publisher functions. Trigger events are
by predefined event publisher functions that are called automatically at runtime. This means that trigger
events are readily available to subscribers by default.

Creating an Event Publisher Function to Publish Business and Integration Events
You create an event publisher function the same way you create any function in C/AL, except that there are
specific properties that you set to make it an event publisher. Additionally, an event publisher function has the
following requirements and restrictions that you must follow, otherwise you not able to compile your code
changes:



An event publisher function cannot include any code except comments.
An event publisher function cannot have a return value, variables, or text constants.

The following procedure provides an outline of the tasks that are involved in creating an event publisher
function for declaring an event. The tasks are performed from the Microsoft Dynamics NAV Development
Environment. For detailed step-by-step instructions for the tasks, see Walkthrough: Using Events in Microsoft
Dynamics NAV.
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To create an event publisher function
1. Decide where you want to include the event publisher function.
You can include an event publisher function in the C/AL code of any object type, such as codeunit,
page, or table. You can create a new object or use and existing object.
2. Add a C/AL function to the object.
We recommend that you give the function a name that has the format On[Event], where [Event] is text
that indicates what occurred, such as OnCancelCustomerApprovalRequest.
3. Set the function Event Property to Publisher.
4. Set the function EventType Property to Business or Integration.

5. If you want to make the event available to event subscribers that are defined in the other objects than
publisher function object, set the Local Property to No.
6. If you want to make global functions in the object available to event subscribers, set the IncludeSender
Property to Yes.
7. Add parameters to the function as needed.
You can include as many parameters of any type as necessary.
Make sure to expose enough information as parameters to enable subscriber functions to add value to
the application. On the other hand, especially with business events, do not expose unnecessary
parameters that may constrain you from changing or extending functionally in the future.
You can now add code to the application that raises the event by calling the publisher function. You can also
create subscriber functions that handle the event when it is raised.
Looking at the existing publications in codeunit 80 there are three predefined publications we can use:

The OnAfterPostSalesDoc publication has been defined as a local function and can therefore only be raised
from inside this object.
The other properties of the function has been set to:
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It is a Publisher event and the type is an Integration.
Creating new Publisher events can be stored in a separate codeunit and it can be raised just by addressing the
the event with Codeunit.PublisherEventName. The only difference is that, the Publisher events local property
my be set to No.

Raising an event
After an event has been published by an event publisher function, you can modify the application to raise the
event where it is needed. Subscribers of an event will not react on the event until it is raised in the application.
To raise an event, you add logic in C/AL code of the application to call the event publisher function that declares
the event. The procedure for calling the event publisher function is the same as calling any other function in
C/AL.
When the code that calls the event publisher function is run, then all event subscriber functions that subscribe to
the event are run. If there are multiple subscribers, then each event subscriber function is run one after another.
The order in which the event subscribers run is random and cannot it cannot be specified.
If there are no subscribers to the published event, then the line of code that calls the event publisher function is
ignored and not executed.

In the case of the OnAfterPostSalesDoc event, it is raised in the end of the main function after everything else
has been executed:

- 21 -

This means that everytime a sales order is posted Dynamics NAV will look for any codeunits that subscribe to
this publication.

Subscribing to Events
To handle events, you design event subscribers. Event subscribers determine what actions to take in response to
an event that has been raised. An event subscriber is a C/AL function that subscribes to, or listens for, a specific
event that is declared by an event publisher function. The event subscriber includes code that defines the
business logic to handle the event. When the published event is raised, the event subscriber is called and its code
is run.
Subscribing to an event tells the runtime that the subscriber function must be called whenever the publisher
function is run, either by code (as with business and integration events) or by the system (as with trigger events).
The runtime establishes the link between an event raised by the publisher and its subscribers by looking for
event subscriber functions.
There can be multiple subscribers to the same event from various locations in the application code. When an
event is raised, the subscriber functions are run one at a time in random order. You cannot specify the order in
which the subscriber functions are called.
Be aware that changing the state may not only impact the publishing code but other subscribers as well.

Subscriber functions cannot access the sender and or access global variables.

Example of an Event Suscriber Function
You create an event subscriber function just like other functions except that you specify properties that set up
the subscription to an event publisher. The procedure is slightly different for database and page trigger events
than business and integration events because business and integration events are raised by event publisher
functions in application code. Trigger events are predefined system events that are raised automatically on
tables and pages.
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In this example we can make a subscriber function to send an email to the customer with the delivery note
whenever a sales order is posted. The process is as follows:
1) Create a new codeunit to hold the subscriber event
2) Create a function
3) Change the properties

4) When selecting the EventFunction the following question is asked

5) This will change the parameters to match the publication event
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6) Now add the code that you want executed

7) Test the subscription event
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Ship the sales order and the mail will pop up:

Be aware that any errors raised in the subscription event WILL be shown as normal, but it will not perform a
roll-back as usual. This means that the order will be posted regardless of any errors raised in the subscription
code.
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Extensions
What are extensions?
How Extensions work
Lifecycle of an extension
Windows PoserShell Cmdlets
Extension Packages
Develop an extension
Building the extension package
To sign an extension package
Publishing and installing extensions
Supported functionality in extensions
Extension example

This chapter is a compilation of available Microsoft material. More information can be found at
https://msdn.microsoft.com/en-us/library/mt574417(v=nav.90).aspx
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What are extensions?
You can extend and customize a Microsoft Dynamics NAV deployment without modifying the original
application objects. With extension packages, you install, upgrade, and uninstall functionality in on-premises
deployments or for select tenants in a multitenant deployment. Customers can easily add or remove horizontal
or customized functionality to their solution that upgrade much easier than past solutions.
In Microsoft Dynamics NAV 2016, you can create extensions to customize pages and tables. The main difference
from classical development is that source code modifications are not allowed. Instead, you use C/AL events to
extend and customize objects.
Extensions are delivered as .navx package files. A .navx package contains the various artifacts that deliver the new
functionality to the Microsoft Dynamics NAV deployment as well as a manifest that specifies the name, publisher,
version, and other attributes of the extension. You manage .navx packages with a series of Windows PowerShell
cmdlets that are available in the Microsoft Dynamics NAV 2016 Administration Shell. There are also cmdlets
available to ISVs and developers in the Microsoft Dynamics NAV 2016 Development Shell that help create
packages.

How extensions work
Extensions are in the simplest terms the runtime application of objects and object deltas for a specific
combination of an extension package and a tenant. When an extension is published to a Microsoft Dynamics
NAV deployment, it compiles the objects in it against the current application database. Then, when the extension
installs for a tenant, it stores the association and builds the relevant database schema. At runtime, Microsoft
Dynamics NAV simply loads the associated objects for that extension and tenant.
You can publish multiple extensions to a Microsoft Dynamics NAV deployment and, in multitenant deployments,
install any combination of published extensions for each tenant. For example, consider a scenario with a
multitenant deployment with extensions A, B, C, and D published to it. Each tenant can have their own unique
combination of extensions. So tenants 2, 3, and 4 can have the same extensions (extensions B and C) while
tenants 1 and 5 only have one extension each, extension A and D, respectively. This provides for a great degree
of customer functionality choice while at the same time maximizes the server hardware and administration
workload.
In most cases, two extension packages can coexist and work independently of each other; however there is the
possibility that two apps will try to modify the same object properties. In those cases, if the conflict cannot be
resolved, the installation of the conflicting extension fails.

Using Extensions
Extensions as a concept are designed for horizontal add-ons that are additive by nature. While not limited to
that premise, following that guideline will increase the ability of your extension to coexist with other
extensions. It will also ensure seamless upgrade across core application versions as well as versions of the
extension.

- 27 -

Code modifications are not allowed in extension packages. This is intended to remove the code-merge task
during upgrade, and to increase the probability that different extensions can coexist.
Changes to a Microsoft Dynamics NAV deployment by an extension are treated differently than if you had
manually added them to your code base. For more information, see Upgrade.
In Microsoft Dynamics NAV 2016, not all core concepts are supported. We have focused on establishing a
strong foundation for extensions that includes the most important and most commonly used elements of an
add-on, such as pages (modifications and full objects), tables (modifications and full objects), code units (full
objects), and menu suites (full objects). For a full list, see the Extension Packages Capability Support Matrix.
Licensing Considerations
Licensing is the same for functionality that is made available in an extension package as in an. fob file. You must
have the relevant license to create and export objects as TXT files. Similarly, your consumers must also have
the appropriate licensing to use your extension.

Lifecycle of an Extension
By design, extension packages are intended to be more easily upgraded, so an extension is based on the
concept of deltas that were introduced in the code upgrade process with Application Merge Utilities in
Microsoft Dynamics NAV 2015. With this tool, you can create delta files for metadata modifications, which then
can be used to merge into a target environment. When you publish an extension, this merging concept is taken
to the next level where a similar delta is merged and compiled against the existing application. The difference is
that the merged object is loaded at runtime as opposed to being embedded in the core source object. Doing
this also permits this merge to be effectively reversed by simply uninstalling the extension package, which
removes that delta object from the deployment.
Development
As a developer, you maintain your extension as a codebase that is separate from the original, and then export
the modified objects as standard object .TXT files. Next, you run the application merge utilities to create delta
files and then build the package with new Windows PowerShell cmdlets that are introduced in Microsoft
Dynamics NAV 2016. To update an extension, you simply repeat that process, incrementing the extension
version number.
Packaging
An integral part of development is the final building of the package. This includes providing the extension with
metadata, such as name, publisher, and version, in a manifest, and packaging that with the application
elements of the extension, such as DELTA files and permission set export files. The end result of that process is
a package of type .NAVX .
Deployment
You administrate extensions by using a set of Windows PowerShell cmdlets to publish extensions to a
Microsoft Dynamics NAV deployment, which makes it available for tenants to selectively install and use. You
can also uninstall extensions for a tenant, or remove an extension from the Microsoft Dynamics NAV
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deployment. Upgrade scenarios, either for a specific extension or the application for this Microsoft Dynamics
NAV deployment, can be accomplished with less friction as extensions, and their functionality are selfcontained and do not contain alterations to C/AL code, removing the need to perform a manual merge.
You can publish multiple versions of the same extension to a Microsoft Dynamics NAV deployment. However,
you can only have one version of the extension installed for each tenant. In a multitenant deployment, one
tenant can run a different version of an extension than other tenants.
Upgrade
Changes to a Microsoft Dynamics NAV deployment by an extension are treated differently than if you had
manually added them to your code base. UI modifications are basically just the differences from the base
application code, and are applied at runtime. Because you cannot modify any existing code in an extension
package, changes in business logic must be done through the use of events and new codeunits. As it is, you can
upgrade your extension independently of the upgrade process of the Microsoft Dynamics NAV deployment as a
whole.
In short, to upgrade an extension, you uninstall the old package and then install a new version of the package.
However, when an extension is uninstalled, all data for the extension is archived into a set of special tables.
When you change tables or add new tables, you must write upgrade code that determines what to do with the
archived data when the extension is installed again.
Move Tenants from One Server to Another
In multitenant deployments, moving a tenant from one server to another requires some evaluation with
regards to your extension packages. The data for any extension is stored within the schema for each company
in the tenant database so that will move without any extra steps. The tenant database also stores information
about which extensions are installed for that tenant. Moving a tenant requires an examination of the
destination server to validate that all extensions for the tenant are published on the on the destination server.
As part of your preparations to move a tenant, review all installed extension packages for the tenant to make
sure the same extensions are available on the destination server. You can use the Get-NAVAppInfo cmdlet to
accomplish this. If the apps are available then you can simply unmount the tenant and move it, as part of the
mount tenant process all installed extensions for the tenant being moved will be re-installed. Please note that
the applications that the two servers use must of course also be identical for this process to succeed.
If your destination server does not have the required extensions, you can alternately uninstall the extension
packages before you dismount to allow the mounting of the tenant on the destination server. The data for
those extensions will be kept in the archived tables until you publish and reinstall that extension, or you choose
to no longer use the extension, at which time you will need to discard the data by removing the archived tables
in the tenant database.
System Tables and Virtual Tables
Extension packages are installed to and operate on a per-tenant basis. To accomplish this, the objects that are
used at runtime are dynamically constructed with any extension deltas that are present for the base object.
The end result is a virtual merge of the base plus the delta for a given extension. Multiple deltas from multiple
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extension packages can also be applied in this process. In Microsoft Dynamics NAV 2016, new system tables are
added to support extensions. We recommend that you only access the system tables using the cmdlets in the
Microsoft Dynamics NAV 2016 Administration Shell and Microsoft Dynamics NAV 2016 Development Shell.
They are listed here for your information only:













NAV App Object Metadata – Stores the metadata deltas for an extension.
NAV App Tenant App – Contains all extensions that are installed to tenants and part of the application
database. This table is synchronized with NAV App Installed App in the tenant databases and is used to
drive runtime decisions about tenant/app relationships. It is also watched for changes by each
Microsoft Dynamics NAV Server instance to support on-the-fly app switching.
NAV App Data Archive – Points to tables created to archive data for extensions that have been
uninstalled. Used to provide access to the data when the extension is reinstalled during an upgrade.
NAV App Installed App – Contains information about extensions that are installed in this tenant. This
lives in the tenant database and is written/read on mount/unmount to make sure tenants keep track of
their apps even when detached from an application database.
NAV App - Contains all extensions that are published to the system. This is part of the application
database.
NAV App Dependencies – List of dependencies for individual extensions that are published to the
system.
NAV App Capabilities – List of capabilities for each extension that is published to the system. Pulled
from the manifest at publication time.
NAV App Object Prerequisites – List of prerequisite objects for individual extensions that are published
to the system.
Tenant Permission Set - Defines the mapping between extensions and permission sets.
Tenant Permission – Contains permissions for objects as defined by permission sets in extension
packages.

The objects from extensions are also included in the following virtual tables
AllObj, AllObjWithCaption includes new objects from all installed extensions based on the current
session/tenant.
AllObj, AllObjWithCaption includes the App Package ID field (empty GUID for base objects, package id GUID if
object comes from an extension)

Windows PowerShell Cmdlets
To help you build, package, publish, install, and manage extensions, Microsoft Dynamics NAV includes a
number of Windows PowerShell cmdlets as described in the following sections.
Development
The Microsoft Dynamics NAV 2016 Development Shell includes the following new cmdlets:
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Area
Manifest

PowerShell Cmdlets
New-NAVAppManifest
Set-NAVAppManifest
Get-NAVAppManifest
New-NAVAppManifestFile
Permissions Export- NAVAppPermissionSet
Packaging
New-NAVAppPackage
Administration
The Microsoft Dynamics NAV 2016 Administration Shell includes the following new cmdlets:
Area
PowerShell Cmdlets
Publishing Publish-NAVApp
Unpublish-NAVApp
Installing Install-NAVApp
Uninstall-NAVApp
Managing Get-NAVAppInfo
Get-NAVAppTenant
Repair-NAVApp

Extension Packages
You deploy your Microsoft Dynamics NAV extensions as packages.
A package file can contain a number of different artifacts that are needed for the extension, such as DELTA files
and full application object .TXT files. The package also contains a manifest with metadata such as name, version,
publisher and, most importantly, a globally unique identifier, the extension ID. Microsoft Dynamics NAV uses the
extension ID to uniquely identify the extension. This ID must be maintained consistently across versions of an
extension in order to upgrade properly. The Windows PowerShell cmdlets that you use to create the manifest
generate an ID for you, but you can also specify an ID.

Extension Manifests
Use the New-NAVAppManifestFile cmdlet to write your manifest to disk so that the App ID is preserved. Then,
you can use the modification cmdlet, Set-NAVAppManifest, to change attributes such as the version number.
The following code snippet illustrates how you can generate a manifest file.
New-NAVAppManifest -Name ‘My Extension’ -Publisher ‘Proseware’ -Version ‘1.0.0.0’ |
New-NAVAppManifestFile –Path ‘C:\MyExtensionManifest.xml’
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The following code example illustrates a manifest for an extension.

At the root of the manifest is the Package element. The following sections describe the other elements and
settings.

App
The App element describes your extension to the system and users. The element has the following attributes.
Attribute
Id

Required Type
Yes
GUID

Name
Publisher
Description
Version

Yes
Yes
No
Yes

String
String
String
String

CompatibilityId Yes

String

Description
An identifier that uniquely identifies the extension. This value should
remain constant for the life of the application, meaning that the same
identifier should be used for each new version of the extension.
A unique identifier will be generated if a value is not provided.
The name of the extension. String length of 250 characters.
The publisher of the extension. String length of 250 characters.
The description of the extension. String length of 2048 characters.
Version string in the format of Major.Minor.Build.Revision. This value
should be incremented for each published package.
Version string in the format of Major.Minor.Build.Revision. This value
defines the compatibility ID of the extension.
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Capabilities
The Capabilities element contains a collection of Capability elements that describe what the extension impacts
in terms of the hosting Microsoft Dynamics NAV deployment. The Capability element can be used to determine
if an extension is allowed to be installed.

Capabilities cannot be set manually as they are added by the packaging process. Microsoft Dynamics NAV 2016
does not provide any functionality for analyzing or otherwise reacting to capabilities. Capabilities are reserved for
future use.

Prerequisites
The Prerequisites element contains a collection of Object elements that define what must be presently
available in the hosting Microsoft Dynamics NAV deployment in order for this extension to function. It uses
specific identifiable object IDs that must be available in the system. If a prerequisite is not found, the extension
cannot install.
Attribute Required Type
Type
Yes
Type

Id

Yes

Description
The type of the object. The following objects are available:
TableData
Table
Report
CodeUnit
XmlPort
MenuSuite
Page
Query
Int32 The object ID.

Dependencies
The Dependencies element contains a collection of Dependency elements that define identifies other
extensions that this extension has a specific dependency on. Dependencies are added to the manifest when
you provide a path to a .navx file in the –Dependencies parameter of the New-NAVAppManifest cmdlet.
Attribute
Id
Name
Publisher
MinVersion

Required
Yes
Yes
Yes
Yes

Type
GUID
String
String
String

Description
The unique identifier of the extension that this extension depends on.
The name of the extension.
The publisher of the extension.
Version string in the format of Major.Minor.Build.Revision. This is the
minimum version of the extension that must be present in conjunction
with the specified Compatibility ID.
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CompatibilityId Yes

String Version string in the format of Major.Minor.Build.Revision. This value
defines the compatibility ID of the extension.

Develop an Extension
You can build extension packages that add functionality to a Microsoft Dynamics NAV deployment. Unlike the
familiar development and deployment of Microsoft Dynamics NAV functionality, building an extension relies on
the exported version of an application to .TXT files. You can export the application from the development
environment, or use the Windows PowerShell function that is available in the Microsoft Dynamics NAV 2016
Development Shell, Export-NAVApplicationObject.
It is recommended that you create a folder structure that can be leveraged by the cmdlets that you use when
you build the extension package. That structure should contain folders for the ORIGINAL object files, MODIFIED
object files, and DELTA files. These names match those used as parameters in the application merge utilities.
To create an extension
1) Establish the BASE as TXT files.
The foundation for your extension is the exported .txt files of the objects you are modifying. You can
export just the objects that you want to modify, or you can export the entire Microsoft Dynamics NAV
application. In the Microsoft Dynamics NAV 2016 Development Shell, the Export-NAVApplicationObject
function can automate this process or you can use the export functionality in the development
environment. The following example uses this function to export objects to establish the base for the
planned modifications.
Export-NAVApplicationObject -Path ORIGINAL -DatabaseName MyDatabase DatabaseServer MyDatabaseServer

Objects must be exported as .TXT files. You cannot build an extension based on a .FOB file.
If you use a source control system, you may want to pull the base .TXT files from there.

2) Create functionality in the development environment.
a.

Use the development environment as usual to create new objects or modify ones to the extent
your license allows you. Keep in mind the following rules:





DO NOT make C/AL code modifications
DO use subscribing to events to execute code.
DO NOT create new or modified XMLPorts, Queries, or Report.
DO NOT change restricted page and table properties.

In order to get an easy upgrade experience for your extensions, you cannot modify code the way
you do in the traditional customization process. Instead, you extend Microsoft Dynamics NAV
functionality by subscribing to programming events that are raised either explicitly in code, or
implicitly by the platform.
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b. Add upgrade code for new or modified tables.
The purpose of the upgrade code is to handle table data that is related to the extension when
the extension is uninstalled and reinstalled. You add the code to two global functions, one
named OnNavAppUpgradePerDatabase and the other
namedOnNavAppUpgradePerCompany.
c.

Test your application with the extension added.

3) Export your changed and added application objects to .TXT files.
Export all objects that you added or modified to .TXT files. Use the same export function from step 1 or
manually export within the development environment. They must also be exported as .TXT files and
should be placed in a separate directory so that the packaging process can be pointed at them.
Export-NAVApplicationObject -Path MODIFIED -DatabaseName MyDatabase DatabaseServer MyDatabaseServer
4) Create DELTA files using the Microsoft Dynamics NAV 2016 Development Shell cmdlets.
Extension packages are based on application object deltas. Again, you use the application merge utilities
in the Microsoft Dynamics NAV 2016 Development Shell to distill the changes in the form of application
object differences that are stored in DELTA files. Creating an extension uses many of the same concepts
and tools as you know from application object deltas. You use the CompareNAVApplicationObject cmdlet to create these delta files.

Compare-NAVApplicationObject -OriginalPath ORIGINAL -ModifiedPath MODIFIED DeltaPath DELTA

Your delta files must be one-to-one with the objects you have added or modified. You cannot include a
single merged delta file. If you output your export file as a single file use the SplitNAVAppplicationObjectFile cmdlet to create the individual files.
5) Build the extension package.
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Building the extension package
After having developed a Microsoft Dynamics NAV extension, the next step is to wrap your new .TXT and .DELTA
files into a .navx file, the packaging format for extensions. The package includes the application objects and
metadata that describes your extension, such as name and version.

To create the extension manifest
The extension manifest describes characteristics about your extension. All characteristics have a parameter in
the Windows PowerShell cmdlet that you use to create the manifest, New-NAVAppManifest. The following
table describes the data in the manifest:
Data
Name
Publisher
Version

Description
Specifies the name of the extension.
Specifies the publisher of the extension, such as your company name.
Specifies the version of the extension. The version is a string in the format of
Major.Minor.Build.Revision, with a default value of 1.0.0.0. You must increment the value
for each new version of the extension that you publish.
Description
Specifies the description for the extension.
Id
Specifies the unique identifier for the extension. A unique identifier will be generated if a
value is not provided. The same unique identifier should be used for each new version of
the extension.
CompatibilityId Specifies the compatibility ID of the extension. The compatibility ID is a version string in
the format of Major.Minor.Build.Revision, with a default value of 1.0.0.0. The value is used
to indicate whether there are compatibility related code changes between different
versions of the extension. If a new version of the extension does not break compatibility,
leave the compatibility ID the same as the previous version.
Dependencies
Specifies the path to a package file (.navx) for another extension that this extension
depends on. Use a comma (,) to separate the paths to multiple .navx files., such as in the
following example: C:\Proseware\SmartAppBase.navx, C:\Proseware\ProsewareBase.navx
Prerequisites
Specifies the objects that must exist in order to deploy the extension to a Microsoft
Dynamics NAV Server instance. The prerequisites is a string in the format of type=ID,
where type can be any object type such as Table, CodeUnit, or Page. Use a comma (,) to
separate the prerequisites, such as in the following example: Table=397, CodeUnit=78.
The New-NAVAppManifest cmdlet creates an in-memory Manifest object.
New-NAVAppManifest -Name "Proseware SmartStuff" -Publisher "Proseware, Inc."
-Version "1.5.0.12" |New-NAVAppManifestFile -Path '.\Manifest- Proseware
SmartStuff.xml' -Force

You can either persist this object to a file and then check it in to source control by using NewNAVAppManifestFile, or you can pass it directly to as described in the next step.
Get-NAVAppManifest -Path '.\Manifest-Proseware SmartStuff.xml' | NewNAVAppPackage -Path MyExtension.navx -SourcePath DELTA
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You have packaged your extension so it is ready to be published and installed on a target server.
The packaging process adds a description of the extension to the manifest, such as whether it changes pages or
adds tables. While not explicitly being enforced currently, this can be used to determine whether to install an
extension, or not. Use Get-NAVAppManifest –Path to see capabilities.
Finally, you can choose to get your extension package signed.

To sign an extension package
To help validate the authenticity of an extension package (the .navx file), we recommend that you have it
signed. Code signing is a common practice for many applications.
1) To sign an extension package, you need a computer that has the following:

a. A code signing tool, such as SignTool or CodeSign.
SignTool is part of the Windows Software Development Toolkit.
For more information, see SignTool.
b. Microsoft Dynamics NAV 2016 or later.
2) Obtain a certificate that is enabled for the code signing purpose. You can have certificate as a file or
installed in the certificate store of the computer.
In production, we recommend that you use a certificate from a third party certificate authority. However,
for testing purposes, it is acceptable to create a self-signed certificate, which, for example, you can create
by using the New-SelfSignedCertificate cmdlet in Windows PowerShell orMakeCert.
The following example uses the New-SelfSignedCertificate cmdlet to create a new self-signed
certificate:

New-SelfSignedCertificate –Type CodeSigningCert –Subject “CN=ProsewareTest”
The following example uses the MakeCert tool to create a new self-signed certificate:
makecert –sk myNewKey –n “CN=Prosewaretest” –r –ss my
3) It is optional but we recommend that you use a time stamp when signing the .navx file.

A time stamp allows the .navx file signature to be verifiable even after the certificate that is used for
the signature has expired.
For more information, see Time Stamping Authenticode Signatures.

4) Sign the .navx file by using your signing tool.

See the following examples for signing by using SignTool.
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Example
The following example signs the Proseware.navx file with the certificate in the password-protected MyCert.pfx
file.
SignTool sign /f MyCert.pfx /p MyPassword "C:\NAV\Proseware.navx"

The following example signs the Proseware.navx file with the certificate in the password-protected MyCert.pfx
file and a time stamp.
SignTool sign /f MyCert.pfx /p MyPassword /t
http://timestamp.verisign.com/scripts/timestamp.dll "C:\NAV\Proseware.navx"

The following example signs the Proseware.navx file with the certificate in the store called My with a subject
name of Prosewaretest.
SignTool sign /n Prosewaretest "C:\NAV\Extension\Proseware.navx"

Publishing and Installing an Extension
To make your extension available to users, the package must be published to a specific Microsoft Dynamics NAV
Server instance. The extension can be installed for one or more tenants.

To publish or remove an extension
Publishing an extension
In the Microsoft Dynamics NAV 2016 Administration Shell, use the Publish-NAVApp cmdlet. The cmdlet takes as
parameters the server you want to install to and the .navx package file that contains the extension. The
following example publishes the extension MyExtension to the YourDynamicsNAVServer instance.
Publish-NAVApp -ServerInstance YourDynamicsNAVServer -Path MyExtension.navx
Publish does more than just update internal tables. It also compiles the components of the extension behindthe-scenes and builds the necessary metadata objects that are used at runtime.
You can get an overview of the published extensions and their state using the Get-NAVAppInfo cmdlet. If no
tenants have a specific extension installed, you can completely remove it using the Unpublish-NAVApp cmdlet.

Removing an extension
In the Microsoft Dynamics NAV 2016 Administration Shell, use the Unpublish-NAVApp cmdlet. The cmdlet
takes as parameters the server you want to remove the extension from, and the name of the extension. The
following example removes the extension MyExtension from the YourDynamicsNAVServer instance.
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Unpublish-NAVApp -ServerInstance YourDynamicsNAVServer -Path MyExtension

Once an app has been published, it must be made available for any tenant that wishes to use it.
To install an extension
In the , use the Install-NAVApp cmdlet. The following example installs the MyExtension for Tenant1 and
Tenant3. In single-tenant deployments, you either specify default as the tenant ID, or you omit the –Tenant
parameter.
Install-NAVApp -ServerInstance YourDynamicsNAVServer -Name ”My Extension” –
Tenant Tenant1, Tenant3

se Get-NAVAppInfo –Tenant command to get an overview of the extensions for that tenant, use the GetNAVAppTenant cmdlet to get all tenants that have installed a specified extension, and uninstall an extension
using the Uninstall-NAVApp cmdlet.
When you uninstall an extension that includes tables and fields, this impacts the database schema and any data
that the tables and fields contain.
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Supported functionality in Extension Packages
An extension package can contain both new and modified existing objects. In Microsoft Dynamics NAV 2016,
the following object types can be added and included in an extension:





Pages
Tables
MenuSuites
Codeunits

You can also modify existing objects of the following types as permitted by your license:




Pages
Tables
Action Items

You cannot add or modify any other object types in this version. Also, you cannot delete any existing objects.

You cannot modify any existing C/AL code, including code in codeunits and in triggers on existing objects. If you
want to modify existing code, use the new C/AL eventing model. This restriction is only on existing code and
objects. New pages, tables, and so on, can contain C/AL code as it is considered part of the new object.
Restricted Properties
There are restrictions on certain property changes for modified objects. The following sections list the
properties you cannot change. The cmdlets that create and install packages will halt with errors if any of these
properties are changed in your extension.
Restricted Properties on Existing Page Modifications
You cannot change the values for the following properties for existing Microsoft Dynamics NAV pages in an
extension.
AccessByPermission
AssistEdit
AutoSplitKey
CardPageID
CharAllowed
ContainerType
ControlAddIn
Data Type
DataLength
DateFormula
DelayedInsert
DeleteAllowed
DrillDown
DrillDownPageID

FieldClass
GroupType
ID
InsertAllowed
LinkedObject
Lookup
LookupPageID
MaxValue
MinValue
ModifyAllowed
MultipleNewLines
Name
NotBlank
Numeric
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PasteIsValid
Permissions
PopulateAllFields
RefreshOnActivate
SourceExpr
SourceTable
SourceTableTemporary
SourceTableView
SubType
SystemPartID
TableRelation
TableType
TestTableRelation
ValidateTableRelation

Editable
ExtendedDatatype

PageType
PartType

ValuesAllowed

Most of these are typically not properties changed through customization as they can have a negative effect on
the Microsoft Dynamics NAV deployment.
Restricted Properties on Existing Table Modifications
You cannot change the values for the following properties for existing tables and fields in an extension.
Table Properties
Name
DataPerCompany
Permissions
LookupPageID
DrillDownPageID
PasteIsValid
LinkedObject
TableType

Field Properties
Name
AccessByPermission
Compressed
Data Type
DataLength
DateFormula
ExtendedDataType
FieldClass
MaxValue
MinValue

NotBlank
Numeric
Owner
SQL Data Type
SubType (BLOB)
TableIDExpr
TableRelation
TestTableRelation
ValidateTableRelation
ValuesAllowed Width

You can add table keys, but you cannot delete or modify existing keys.
You can add fields to a table group, but you cannot remove fields or groups.

Extension example
One example of an application that can function as an extension could be an add-on module to the sales
module handling subscriptions. Subscriptions in Dynamics NAV always prove tricky to implement promarily
because they are recurring but also because they cannot represent a inventory value if items are used for the
invoicing.
The functional requirements are:
1) A new tabel: Subscriptions must be created to identify each type of subscription
The Table must hold the following information:
- Subscription code
- Subscription text
- Item Number
- Invoicing Schedule
- Invoicing Frequence
- Invoicing Price
- Deferral Code
2) Card pages and list pages for the subscriptions
3) A Fact Box to show the number of active subscriptions etc.
4) A customer must be assigned one or mors subscriptions and therefore another table must be added:
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5)
6)
7)
8)
9)
10)
11)
12)
13)

- Customer No
- Subscription Code
- Item No
- Created date
- Last Invoice Date
- Next Invoice Date
- Cancelled Date
- Active
- Invoicing Price
- Allow Line Discount
A List page for the customer subscriptions
A Fact Box to show the active subscriptions etc.
New Field on the Customer to show if the customer is an active subscription customer
This is to be able to make a Cue for subscription customers later
The customer card and list must be altered with extra fields, actions and the FactBox.
New Field on the Customer to show if the customer is an active subscription customer
This is to be able to make a Cue for subscription customers later
The Item card and list must be altered with extra fields, actions and the FactBox.
A codeunit to create the invoices
Make a subscription event to update the subscription customer table when posted
A New MenuSuite must be created with the subscription menu items

The first thing to do is to create a backup of all objects that will be affected by the changes:

The objects must be exported in a text format to be used when building the delta files.
The original are stored in a newly created folder structure:
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Development
Next the application is built:

All changes to the code has been added as functions and subscriptions events in a codeunit:
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The testing
Three new subscriptions:

A number of items are created:
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Then a number of customers are assigned subscriptions:

Each customer has been assigned at least one active subscription:

Now it is possible to create invoices:
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And the confirmation:

The Invoices:
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The invoice looks like a normal invoice:

But posting it will update the CustomerSubscription table:

Mission Accomplished.
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Creating the navx package
The first thing is to create the delta files:

This will create a number of files:
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Then the manifest must be created:

In this case the manifest is created and then “piped” into the next command, which will save the manifest as a file.
The file looks like this:

Lastly the package must be created:

And the navx package is ready:
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Publishing and installing the package
The next thing to do is to publish the package to the server instance where it is needed. In this case the server
instance is: DynamicsNAV90 which is a totally clean database.

To see, which apps are published on the server instance, use the GetNAVAppInfo Cmdlet:

Lastly the package must be installed
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Testing the App
Opening the DynamicsNAV90, the Departments menu is the place to look:

It is possible to create subscriptions:
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And the amount of changed objects are:

Zero.
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Building workflows
What is a workflow?
Create a workflow event
Create a workflow response
Enable the workflow & response in the NAV system

This chapter is a compilation of available Microsoft material. More information can be found at
https://msdn.microsoft.com/en-us/library/mt574349(v=nav.90).aspx
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What are workflows?

•

A workflow is a movement of steps or tasks through a work process

•

Workflows help connect business processes to best practices or industry-standard practices

•

For example, ensuring a customer’s credit limit has been verified

•

For example, requiring a two-person approval of a significant vendor payment

•

In Microsoft Dynamics NAV 2016, a workflow is likely to contain steps related to approval, notification,
or business-process automation
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Workflows
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Nav 2016 Workflow & Notification Schema

Categories:

A grouping of the workflow template, e.g. Administration, Finance, Integration.

User Group:

A group of approvers to approve the workflow either simultaneously or sequentially.

Template:

Base for the actual workflow.

Event:

The situation that triggers the workflow on a given condition.

Response:

The action taken depending on the state.

Workflow:

The actual workflow that will be executed.

Notification:

The message sent by email.

Approval:

The approval request entries that requires an action from the approver.
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Out-of-the-box workflows in Dynamics NAV 2016

•

A workflow is a movement of steps or tasks through a work process

•

Workflows help connect business processes to best practices or industry-standard practices

•

For example, ensuring a customer’s credit limit has been verified

•

For example, requiring a two-person approval of a significant vendor payment

•

In Microsoft Dynamics NAV 2016, a workflow is likely to contain steps related to approval, notification,
or business-process automation
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Setting up for credit limit approval

•

Set up users in approval hierarchy

•

Create a workflow user group and apply the users to the group

•

Create a new workflow from one of the existing templates

•

Link the workflow to the workflow user group

•

Test the workflow
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Setting up for credit limit approval

•

Set up users in approval hierarchy
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Setting up for credit limit approval

•

Create a workflow user group and apply the users to the group

•

Using the same Sequence No. the approval request will be sent to both approvers at the same time

•

Using a higher Sequence No. for Phil, the approval request will first be sent for approval to Susan and
later to Phil
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Create a new workflow from one of the existing templates

•

Using the “Create Workflow from template”
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Adjusting the workflow

•

In the workflow, the approval group must be assigned to the workflow

•

Then the workflow can be enabled
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Testing the workflow

•

Logging on as Annie

•

Annie changed the credit limit field to 10.000

•

When she pressed ok the message appears
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Testing the workflow

•

Looking at the customer now, it is apparent that the credit limit has been reset pending the approval
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Testing the workflow

•

Logging on as Phyllis the approval request appears in the inbox

•

I email notification has been set up, Phyllis have received a mail by now
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Testing the workflow

•

Logging on as Susan the approval request appears in the inbox

•

I email notification has been set up, Susan have received a mail by now
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Testing the workflow

•

After the last approval, the value of the credit limit on customer 10000 has changed
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Workflow architecture

•

Header information

•

Category: to place the workflow in the hierarchy

•

Enabled: Enable the workflow
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Workflow architecture

Workflow steps:
1) Which Workflow events should be used
2) What should trigger the workflow
3) What should the response be
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Workflow architecture

Workflow steps:
1) Which Workflow event should be used
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Workflow architecture

Workflow steps:
2) What should trigger the workflow
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Workflow architecture

Workflow steps:
3) What should the response be
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Labs – Workflows

•

Set up a new customer credit limit
workflow from a template

•

Test the workflow
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Create a workflow event
Get started by opening the Development Environment and Object Designer.
For the event we need a new codeunit.

First we’ll make a helper method for binding our event with the workflow engine.
The method is a simple one which returns and identifying code.
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Next we add another method which will be called whenever there is a change to the Campaign table.
More specifically, this method will be called just after the OnAfterModifyEvent trigger for the table is called.
It’s the perfect time for us to catch the event and run our workflow code.
For the code itself, we’ll do two things
•
•

Show a message box so we can see our event did trigger
Call into the workflow engine to have the NAV Workflow engine process any next steps
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Then we need to add another event subscriber method which is responsible for adding our event to the
workflow library. The workflow library is the collection of events which can be seen and managed from the
Workflow Setup page.
To add a Workflow event we need to do three things:
•
•
•

Subscribe to the event.
Define a user readable string which describes the event.
Call a method in the workflow event handling codeunit, passing in the identifier and the descriptive string.
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And a local text constant

And a local variable

Now subscribe to the event:
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Build a workflow response
Get started by opening the Development Environment and Object Designer.
For the response we need a new codeunit.

First we’ll make a helper method for binding our response with the workflow engine.
The method is a simple one which returns and identifying code.

Then we need to add another event subscriber method which is responsible for adding our response to the
workflow library. The workflow library includes the collection of responses which can be seen and managed
from the Workflow Setup page.
To add a Workflow response we need to do three things:
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•
•
•

Subscribe to the event which adds new responses to the workflow library
Define a user readable string which describes the response
Call a method in the workflow response handling codeunit, passing in the identifier and the descriptive string.
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Eventually we will need the actual response code to call. We’ll add this now so we can have the workflow
engine invoke it when needed.
We’ll write the code for it later..

The earlier functions were used to add the response to the workflow library.
But we need another method that actually listens to when the response needs to be called.
When this code is called it needs to do two things.
Firstly it needs to evaluate if the response should be called (and it does this by checking the code value) and
secondly it should return TRUE if it handles the response.
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Add variables and then the code from the screenshot.
Notice that the call to RunReport and setting the Response Executed to TRUE happen only if we match to the
workflow response code.
In this demo script, we’ll run a specific report and save it in the report inbox. Going further, NAV Workflow
allows you to build options and conditions so you can tailor what the event and response should do under
specific conditions.
A future and improved version of this response would be to run any particular report and to specify which
report and which report options should be used as part of workflow setup.

Enable the workflow event in the NAV system
Get started by opening the client and searching for the workflow management page.
We make a new workflow and give it an identifier.
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Workflows in Dynamics NAV follow a pattern we call “When, Then”. The meaning is to think about workflows
as “When something happens, Then do something”. The Whens are Events and the Then are responses.
Using the workflow steps grid, we build the steps of our workflow. In this case we can use Dynamics NAV’s
drop down picker to select our new workflow event. We can recognize it from the description we coded
earlier. After picking the event, we select under what conditions it should run. Here we want to only fire
events when the status of a Campaign is Closed.
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After picking the Event, we select a response. In this case we’ll pick “Run a Report” because all we want to do
is see that it works.

This now represents a simple workflow we can build.
Clicking ‘Enabled’ will activate the workflow and it will be live in our system.

To test if our workflow works, we’ll jump to the Campaign page and edit one of the campaigns, setting the
value to Done and confirm the change.
When we do this, we see the dialog box showing that our event fired and was run from the Workflow Engine.
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Now we want to see the report itself.
We’ll jump back to the Role Center and look in the report inbox.
Notice in the report inbox fact box there is a new entry.
From here we can see the report we just ran and open it!
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Click Open on the file dialog and the PDF file will open!
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Test automation
How to start using the application test suite
Managing test suites
Test selection by churn
Failure analysis

This chapter is a compilation of available Microsoft material. More information can be found at
https://msdn.microsoft.com/en-us/library/dn951441(v=nav.90).aspx
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How to start using the application test suite
The Application test suite contains tools for managing and executing tests, application tests and helper
functions grouped in libraries. To run tests in the CAL Test Tool window, you must import the objects in the
.fob files in the TestToolkit folder that is included on the Microsoft Dynamics NAV product media.
It is enough to import CALTestCodeunits.W1.fob and CALTestLibraries.W1.fob.
CALTestRunner.fob is already part of demo database.

Now we are ready to run the standard application tests.
In the current demo script we will use the Test Tool for running tests. There are two options to run the Test
Tool:
1. Run the CAL Test Tool page (130401) directly from the Development Environment
2. Run Test Tool from windows client.
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In this demo scenario we select all available test codeunits for execution by choosing the All Test Codeunits
option.
After Microsoft Dynamics NAV finishes loading all test codeunits, they are displayed on the Test Tool page.
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The loaded tests will take about several hours to run depending on your machine and the setup.
When the execution is completed it will show the results in the Test Tool page.

Alternatively, you can run individual codeunits by selecting them and clicking Run Selected action.
Another option is to choose either Active Line or Active Codeunit after clicking the Run action. Run field may
help if needed to exclude some tests of test codeunits.

Managing test suites
The Test tool supports multiple lists of tests grouped in different test suites.
The new test suite can be created similar to journal or worksheet batches.
Notice the field Update Test Coverage map, which we will be used in next demo script.
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In current scenario we will not add all available test codeunits but only the needed subset. To do this we select
the option Select Test Codeunits.
The CAL Test Get Codeunits window will be opened. This page displays all available test codeunits, including
your own.
Added codeunits can be executed as was described earlier.
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You can export the test suite into XML format and share it with your colleagues.
For example, the exported test suite might contain tests related to a specific project or modification. Or
exported test suite might contain tests related to the most important or critical functionality of application and
should be executed more often than other tests.
To import the tests use the Import action on the Action ribbon.
The exported test suite can be used as input for automated test execution.

Test selection by churn
During development, it is not feasible to have to wait long to get the results from tests. Therefore we build the
Test Coverage Map feature, which helps you narrow the set of tests down to the relevant tests.
The feature works by analyzing the code coverage data from individual test codeunits and comparing it to the
set of objects that have to be tested. This is called the test coverage map and it is stored in table 130406 CAL
Test Coverage Map.
The Test coverage map can be created during the test execution. Activate checkbox “Update Test Coverage
Map” on the test suite and all test executions will update the test coverage map data.
You can notice how Hit Object was changed. It displays related data from the Test Coverage Map table.
Pay attention that you can export and import the Test Coverage Map with the actions Import and Export
located in the ribbon.
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How can we benefit from the Test Coverage Map? For example, you merged an add-on and wants to be sure
that this did not cause any regression in existing functionality. You know which objects were modified in this
Add-on and you want to run a subset of tests relevant for these objects.
As Test Coverage Map is now available, the prompt which appears when you click Get Test Codeunit action,
will now include two new options.
Once you select the option Get Test Codeunits Based on Selected Objects the system shows you the list where
you can choose the objects for tests. In this demo script we will test tables related to Sales Credit Memo.
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Only two test codeunits were added. The execution of two codeunits is much faster than the execution of
hundreds.

Failure analysis
In this demo the developer did some modifications which affects standard functionality.
For example, on customer’s request he deleted the "Outstanding Orders (LCY)" field from Vendor Statistics
page.
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The developer wants to be sure that his modification didn’t cause regressions in standard functionality.
With help of the Test Coverage Map he finds out that for modified object exists only one test codeunit.
As result of the test run, he discovered that 4 of 9 tests failed.

In the window CAL Test Result it’s possible to see test results with additional details.
This page allows a developer to see the call stack, which help understand the reason of failure or at least helps
to find out place to set break point.
Make sure that test results can be exported in XML format and shared with other developers.
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Designing pages for the Universal App
Designing for Different Screen Sizes on Tablet and Phone
Differences and Limitations When Developing Pages for the Microsoft Dynamics NAV Universal App
How to: Implement the Camera in C/AL
How to: Implement Location in C/AL

This chapter is a compilation of available Microsoft material. More information can be found at
https://msdn.microsoft.com/en-us/library/dn757143(v=nav.90).aspx
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Designing for Different Screen Sizes on Tablet and Phone
When designing application pages for the Microsoft Dynamics NAV Tablet client and the Microsoft Dynamics
NAV Phone client, it is best practice to consider the size of the tablets or phones that your end-users have
access to. It is an advantage if the solution works well on both small screen sizes and also on larger screen sizes,
but we also recommend that you consider thoroughly the most frequently used screen sizes for your end-user
experience. Designing for small screens can be a challenge, because pages will show fewer fields, columns, and
tiles.
In many cases, end-users will have access to a broad range of devices having different screen sizes and
resolutions. End-users may have one device at work, and a different device at home, and expect the experience
on both devices to be equally good. A good way to identify issues on how your application pages will look is to
test on the smallest supported screen size. Currently tablet sizes start in the 7” range and phones range from
3” up to just below 7”. There are certain requirements for running the Microsoft Dynamics NAV Universal App
on tablets and phones.

Form Factor Considerations
Users can scroll the content area of the Microsoft Dynamics NAV Universal App on a tablet to access all data for
a given page. However, some elements of the screen, for example, the app bar cannot be scrolled. The app bar
is the blue area of Microsoft Dynamics NAV Universal App and it is designed to provide easy access to
important information and tasks that the user should not lose sight of when scrolling. The static elements will
display only as much data as they can reasonably fit on the screen. Developers should design to make sure that
the important static elements are displayed first so that these will be shown even on the smallest, available
devices.
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On phones there is no app bar, and the Microsoft Dynamics NAV Universal App displays only one part at a time
on the Role Center. On the Home page, the Activity tiles are always displayed first, and you navigate through
the top menu to explore the content area.
Guidance for Page Element Types on Smallest Tablet Devices
The following table provides a list of non-scrollable elements in the page content or the app bar.
Page Type
RoleCenter
List Pages
Card Pages

Displays on smallest tablet device
4 tiles in 1 group, or 2 groups together with 2 tiles
5 columns of type Text50 or 8 columns of type Text20
CardPage Factbox with up to 15 fields
2 CardPage Factboxes with up to 6 fields each
Activities Factboxes with 4 tiles in 1 group, or 2 groups together with 2 tiles
Document Pages CardPage Factbox with up to 15 fields
2 CardPage Factboxes with up to 6 fields each
Activities Factboxes with 4 tiles in 1 group, or 2 groups together with 2 tiles

Testing Using a Browser
Using a browser you can test how your application pages will look on various device sizes. When running
Microsoft Dynamics NAV Tablet client or Microsoft Dynamics NAV Phone client in a browser, you can use
Microsoft Edge Developer Tools to emulate different screen sizes.
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Differences and Limitations When Developing Pages for the Microsoft Dynamics NAV Universal
App
Developing for the Microsoft Dynamics NAV Tablet client and Microsoft Dynamics NAV Phone client is not
much different from developing for the Microsoft Dynamics NAV Windows client, or Microsoft Dynamics NAV
Web client. There are, however, some natural limitations on tablets and phones, such as not having a physical
keyboard and mouse, as well as a smaller screen. In addition to this, there are some differences and limitations
in developing pages for Microsoft Dynamics NAV Tablet client and Microsoft Dynamics NAV Phone client. The
differences and limitations listed are additional to the differences and limitations that exist on the Microsoft
Dynamics NAV Windows client and Microsoft Dynamics NAV Web client.
Differences and Limitations Overview
The following table describes some of the most common differences and limitations that you might experience
when developing for Microsoft Dynamics NAV Tablet client and Microsoft Dynamics NAV Phone client.
Concept

On Tablet

On Phone

Activity buttons

Only the Home
activity button is
shown.

Only the Home
activity button is
shown.

Selecting multiple
records in lists

Not available.

Not available.
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Example

Recommendatio
n
Home,Departments Design pages to
, and Posted
expose the
Documentson the
workflows
Sales Order
needed by the
Processor Role
user. For
Center.
example,
configure the
profile to show
the important list
pages under the
Home activity
button.
Alternatively,
consider
designing a new
Role Center if the
activities for the
activity button
greatly vary from
activities in other
activity buttons.
Ctrl+A or Ctrl+Click Avoid scenarios
on rows in a list
requiring
using Microsoft
selecting
Dynamics NAV
multiple rows on
Windows client.
a list. Also, try to
minimize actions
on lists.

Ribbon actions

Only Promoted
actions are shown.

Only Promoted
actions are shown.

FactBoxes

Not shown on List
pages or Worksheet
pages.

Not shown on List
pages or Worksheet
pages.

Advanced filters

No column-specific
filtering is available.

No column-specific
filtering is available.

Page search

Not available.

Not available.

Cue and action tiles

The number of tiles
that are shown is
based on the size of
the screen, no
possibility to scroll.

The number of tiles
on the phone is in
theory unlimited
because you can
scroll.

Fields in fast tabs

Fields in fast tabs on Not available.
list pages are not
shown. Only the
repeater control is
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On the Small
Business Role
Center.

Use the
development
environment to
promote actions.
Alternatively,
configure the
profile and add
actions to the
Home ribbon tab.
Customer list on
Make sure the
the Small Business
same
Role Center.
information is
visible on the
corresponding
card page of the
given record.
On the Customer
Send data to
list page.
Excel and do the
complex filtering
there.
On Microsoft
Design pages to
Dynamics NAV
expose the
Windows client or
workflows
Microsoft
needed by the
Dynamics NAV Web user. For
client.
example via list
places, tiles or
actions.
On most Role
Design Role
Center pages.
Center pages to
avoid having
important tiles at
the area end.
Assume you have
no control over
how many tiles
are displayed and
consider that
only the first few
tiles will be made
visible on the
tablet.
Design List pages
to avoid having
important
columns on the

shown in the
content area of the
page.

Links and Notes

Not available.

Not available.

On Sales Orders.

Select from full list

Not available on
lookups. Users are
not able to run
actions on a lookup
page, and they
cannot access the
full set of records.

Not available on
lookups. Users are
not able to run
actions on a lookup
page, and they
cannot access the
full set of records.

On the Item
Card when
selecting theBase
Units of Measure.

Search across list
columns

Partly supported.
Search will not
include FlowFields.
There is no Preview
functionality
available on the
Microsoft Dynamics
NAV Tablet client.
CurrReport.PREVIE
W cannot be
reliably used to
identify whether a
report was run as a
draft or as a final
printed document.

Partly supported.
Search will not
include FlowFields.
There is no Preview
functionality
available on the
Microsoft Dynamics
NAV Phone client.
CurrReport.PREVIE
W cannot be
reliably used to
identify whether a
report was run as a
draft or as a final
printed document.

On the Customer
list page.

Report Viewer and
CurrReport.PREVIE
W
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See example in
report 280.

far right of the
column list.
Assume you have
no control over
how many
columns are
displayed and
consider that
only the first few
columns will be
made visible.
Similar to
Factboxes, make
sure the same
information in
the field group is
visible on the
corresponding
card page of the
given record.
Make sure the
appropriate
columns are
visible on the
lookup. The user
is still able to
filter, scroll, and
search through
the lookup.

Lookups

Available.

Available, with the
difference that
advanced and
simple lookups
behave similarly on
the phone. The
lookup will not
bring up the card,
show factboxes, or
any field groups.
Not available.

Matrix controls

Not available.

File download

Worksheet pages

Available. Cannot
download multiple
files at the same
time.
Available.

Available. Cannot
download multiple
files at the same
time.
Not available; an
error message is
displayed.

Lists

Available.

Indentation in
repeater controls

Available.

Scope of actions

Available.

Available, with the
difference that
these are displayed
in a brick layout
with a number of
differences and
limitations. For an
overview, see How
to: Display Data as
Bricks on Phone.
Not available. The
repeater control will
be rendered as a
regular flat brick
layout.
Available, but there
are some behavioral
differences
regarding the Scope
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See examples on
the Customer Card
page.

See example in G/L
Budget.
Trial Balance report
in thePrint to
Excel check box.
Sales Price
Worksheet or Cash
Flow Worksheet.

Customers or Sales
Orders pages.

Chart of Accounts
and Contacts List
pages.

Run this type of
page from the
Microsoft
Dynamics NAV
Windows client,
Microsoft
Dynamics NAV
Web client, or
Microsoft
Dynamics NAV
Tablet client.

Use of camera and
location

Available in the
Microsoft Dynamics
NAV Universal App
on devices with a
camera and GPS
capabilities.

Property. Also,
see Defining Action
Scope for Microsoft
Dynamics NAV
Pages.
Available in the
Microsoft Dynamics
NAV Universal App
on devices with a
camera and GPS
capabilities.

Note

Note

Not available on
Microsoft Dynamics
NAV Windows client
or Microsoft
Dynamics NAV Web
client.

Not available on
Microsoft Dynamics
NAV Windows client
or Microsoft
Dynamics NAV Web
client.
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On the Accounting
Manager profile,
under Incoming
Documents

How to: Implement the Camera in C/AL
This example illustrates how you can add access to camera to a specific page from the development
environment. Adding a camera option to the Item card, for example, lets you take a picture of a specific item
and store it with the item. The example implements three actions; Take Picture, Take Picture High Quality, and
Take Picture Low Quality on the Customer Card page, but does not include code that saves the picture to the
database. For a Microsoft Dynamics NAV implementation of this, see Incoming Documents, for example on the
Accounting Manager profile, when you use the Dynamics NAV app on a phone.
The camera access is only available on devices that run the Microsoft Dynamics NAV Universal App and have a
camera. This means that camera access is not available from the Microsoft Dynamics NAV Windows client or
from a browser.
With the following steps, you will create two variables; the CameraAvailable variable is a Boolean that checks
whether the current device has a camera. The Camera variable is a DotNet type that gets instantiated by
adding code to the OnOpenPage trigger. Then, you will add actions to the Customer Card page that lets the
user start the camera and write the code that is run on these actions. And finally, you will add a new trigger
Camera::PictureAvailable to handle the incoming picture.
To implement the camera in C/AL
1. In the development environment, on the Tools menu, choose Object Designer to open the Object
Designer window.
2. In Object Designer, choose Pages, select the Customer Card (page 21) and choose the Design button.
3. From the Page Designer window, on the View menu, choose C/AL Globals.
4. Create the following two variables:
Variable name
Camera

DataType SubType
DotNet
Microsoft.Dynamics.Nav.Client.Capabilities.CameraProvider
Important
Choose the Microsoft.Dynamics.Nav.ClientExtensions dll on the Server tab,
and then choose
Microsoft.Dynamics.Nav.Client.Capabilities.CameraProvider. Make sure to
set the properties RunOnClientand WithEvents to Yes.
CameraAvailable Boolean
5. On the View menu, select C/AL Code and in the C/AL Editor locate the OnOpenPage trigger.
6. Instantiate the Camera variable by adding the following code to the OnOpenPage trigger

7. Next, create the page actions. Choose the View menu, and then select Page Actions.
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8. Locate the ActionGroup named Customer and create three actions; TakePicture, TakePictureHigh, and
TakePictureLow all of them with the following properties set as shown in the following table.
Property
Name
Visible
Promoted
PromotedCategory
PromotedIsBig
Image

Value
TakePicture
CameraAvailable
Yes
Process
Yes
Camera

9. Next, you will add the code that is executed on the actions. On the TakePicture OnAction trigger, insert
the following line of code:

10. On the TakePictureHigh OnAction trigger, insert the following lines of code:

11. On the TakePictureLow OnAction trigger, insert the following lines of code:

12. You now need to declare the local variable CameraOptions for the TakePictureHigh and
TakePictureLow triggers. From the Page Designer window, on the View menu, choose C/AL Locals.
13. Create the following variable:
Variable name DataType SubType
CameraOptions DotNet
Microsoft.Dynamics.Nav.Client.Capabilities.CameraOptions
Important
Choose the Microsoft.Dynamics.Nav.ClientExtensions dll on the Server tab,
and then choose Microsoft.Dynamics.Nav.Client.Capabilities.CameraOptions.
14. You must now add code to handle the picture for when the camera has captured the picture and the
picture has been uploaded to the Microsoft Dynamics NAV Server. In the C/AL Editor, on the
PictureAvailable trigger, add code so that the PictureAvailable trigger looks like this.
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The PictureName contains the name of the file including its extension on the device. The naming
scheme depends on the device platform. The PictureFilePath contains the path to the picture in a
temporary folder on the server for the current user.
It is important to clean up by using the FILE.ERASE command to avoid accumulating image files.

15. Now, you need to declare the local variable IncomingFile used in the PictureAvailable trigger. From the
Page Designer window, on the View menu, choose C/AL Locals.
16. Create the following variable:
Variable name DataType
IncomingFile
File
17. Close the C/AL Editor and then save and compile the page
You can now test the modified Customer Card page in the Microsoft Dynamics NAV Universal App from either a
tablet or a phone with a camera.
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How to: Implement Location in C/AL
This example illustrates how you can retrieve location information. The example implements
a GetLocation action on the Customer Card (page 21) that returns the GPS coordinates of the current customers
address. It does not save this information to the database. Scenarios in which this functionality could be useful
would be displaying a map that shows where your customer is located based on the GPS coordinates. Or,
functionality to plan the next round of customer visits based on the addresses of your customers.
The location information is only available on devices that run the Microsoft Dynamics NAV Universal App and
have GPS capabilities. This means that location information is not available from the Microsoft Dynamics NAV
Windows client or from a browser.

To implement location in C/AL
1. In the development environment, on the Tools menu, choose Object Designer to open the Object
Designer window.
2. In Object Designer, choose Pages, select the Customer Card (page 21) and then choose the Design
button.
3. From the Page Designer window, on the View menu, choose C/AL Globals.
4. Create the following variable:
Variable name
Location

DataType SubType
DotNet
Microsoft.Dynamics.Nav.Client.Capabilities.LocationProvider
Important
Choose the Microsoft.Dynamics.Nav.ClientExtensions dll on the Server tab,
and then choose
Microsoft.Dynamics.Nav.Client.Capabilities.LocationProvider Make sure to
set the properties RunOnClientand WithEvents to Yes.
LocationAvailable Boolean
5. On the View menu, select C/AL Code and in the C/AL Editor locate the OnOpenPage trigger.
6. Instantiate the Location variable by adding the following code to the OnOpenPage trigger.

7. Next, create the page action. Choose the View menu, and then select Page Actions.
8. Locate the ActionGroup named Customer and create a new action; GetLocation with the following
properties.
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Property
Name
Visible
Promoted
PromotedCategory
PromotedIsBig

Value
GetLocation
LocationAvailable
Yes
Process
Yes

9. Now, in the C/AL Editor, on the GetLocation – OnAction trigger, insert the following line of code.

10. While still in the C/AL Editor, on the LocationChanged trigger add the following code to handle the GPS
coordinates. LocationChanged is called when the device has obtained a status.

Location.Status can be 0 = Available, 1 = NoData (no data could be obtained), 2 = TimedOut (location
information not obtained in due time), or 3 = NotAvailable (for example user denied app access to
location).
11. Close the C/AL Editor, and then save and compile the page.
12. You can now test the modified Customer Card page in the Microsoft Dynamics NAV Universal App from
either a tablet or a phone with GPS capabilities.
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